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Complex measurement systems can be easily built with
LambdaCAN*, NOxCAN*, and baroCAN modules. Here is a
five-channel lambda, O,, and NOx pressure-compensated in-

vehicle system.



Introduction

ECM offers three NOx module kits: NOXCANt (“Type T”’), NOXCANg (“Type G”), and
NOXCAN (the original NOXCAN kit). The modules use different NOx sensors and must be
matched to the correct module (i.e. a NOXCANt sensor cannot be used with a NOXCANg
module). See Appendix A for kit contents. The specifications for the kits are as follows:

NOxCANt Kit:

Recommended for general-purpose NOx measurement for combustion processes that can be
rich, lean, and stoichiometric (i.e. all Lambda. ex. spark ignition engines).

Ranges: NOx: 0 to 5000 ppm (wet), (For all )
A (Lambda): 0.4 to 25
AFR: 6 to 364
%02: 0 to 25% (wet)
Accuracies: NOx: + 20 ppm (0 to 1000 ppm), £ 2% (elsewhere)
A, AFR, ¢: £ 0.8% (at stoichiometric), + 1.8 (average, elsewhere)
%02: = 0.2% (absolute)
Response Times: NOx: Less than 1 sec., A, AFR, ¢, O2: Less than 150 ms
Sensor Mounting: 18mm x 1.5mm thread

NOxCANg Kit:

Recommended for NOx measurement for combustion processes that are only lean of
stoichiometric (i.e. Lambda > 1. ex. diesel engines).

Ranges: NOx: 0 to 5000 ppm (wet), (For A > 1 only)
A: 041025
AFR: 6 to 364
%02: 0 to 25% (wet)
Accuracies: NOx: = 15 ppm (0 to 1000 ppm), + 1.5% (elsewhere)
A, AFR, ¢: £ 0.8% (at stoichiometric), + 1.8 (average, elsewhere)
%02: = 0.2% (absolute)
Response Times: NOx: Less than 1 sec., A, AFR, ¢, O2: Less than 150 ms
Sensor Mounting: 20mm x 1.5mm thread

NOXCAN Kit (The “Original” NOXCAN Kit):

For all Lambda; however, recommend using NOXCANt or NOxCANg Kit for new
applications.

Ranges: NOx: 0 to 5000 ppm (wet), (For all )
A: 041025
AFR: 6 to 364
%02: 0 to 25% (wet)
Accuracies: NOx: = 30 ppm (0 to 1000 ppm), + 3% (elsewhere)
A, AFR, ¢: £ 0.8% (at stoichiometric), + 1.8 (average, elsewhere)
%02: = 0.2% (absolute)
Response Times: NOx: Less than 0.7 sec. (NOx), A, AFR, ¢, O2: Less than 150 ms
Sensor Mounting: 18mm x 1.5mm thread

For all Pressure-Compensated Kits: 0 to 75 psia (517 kPa) range, + 5.2 kPa (x 0.75 psia)




Setup and calibration of NOxXCAN™* kits is performed using the supplied PC software
program called “The Configuration Tool”. The Configuration Tool uses a CAN
communication device to communicate with one or more ECM *CAN modules (i.e.
NOxCAN*, LambdaCAN*, baroCAN, appsCAN) or analyzers (i.e. NOx 5210, Lambda
5220, EGR 5230). While the tool is being used with modules, just ECM modules set to
stand-alone mode (see Appendix B) should be connected to the CAN bus. While the tool is
being used with analyzers, just analyzers should be connected to the CAN bus. With
analyzers, the Configuration Tool is just used to produce .dbc files. However with modules,
the Configuration Tool replaces the analyzer’s display head as the user interface so it must do
much more. This document focuses on using the Configuration Tool with ECM’s
NOxCAN* modules.

The Configuration Tool supports four CAN communication devices: Kvaser, ETAS, Peak
USB-to-CAN adapters, and the VectorCAN CAN adapter card. Driver software for one of
these adapters must be installed prior to using the Configuration Tool. This software will be
supplied with the adapter or be available on-line. ECM’s Configuration Tool is delivered on
aCD.

Once the adapter’s driver and the Configuration Tool software are installed, and with the
module(s) powered and connected to the CAN adapter, start the Configuration Tool software.
Click on the “Modules” tab, select the CAN adapter, and click on the “START” button.

The software will identify the modules on the bus and display them in the “Module” field. If
this does not happen, make sure that the CAN bus is properly terminated (i.e. resistors).
Open the Module field to see all the modules on the bus. If a module is not listed, one reason
could be that its Node ID is the same as another module. To resolve this, remove all modules
except the “missing” one from the CAN bus, STOP then START the software, and change
that module’s Node ID. Another reason that a module is not listed could be that the module
is in EIB mode instead of stand-alone mode. All modules must be in stand-alone mode.

To configure one of the modules (ex. change its Node ID) or to look at that module’s data,
you have to select that module in the “Module” field.

There are three things you can do with modules using the Configuration Tool:

1. Configure a module. This includes calibrating a sensor attached to the module.
2. Look at data coming from that module in real-time and optionally log it.
3. Produce a .dbc file to be used by a device receiving module data.

Alternatively, 1. and 2. (above) can be performed by direct CAN communication with the
NOxXxCAN* module using user-written software. For information on how to do this and
detailed information about the modules, refer to the NOXCANt, NOXCANg, or NOXCAN
Instruction Manual.



Configuring a Module

Normally, you will be configuring a module to be used in stand-alone mode. Stand-alone
mode is used when the modules are connected to a CAN bus that goes directly to a data
acquisition system. In stand-alone mode, a module’s configuration is performed by selecting
one of the tasks in the “Task” field. When a module is connected to a NOx 5210, Lambda
5220, or EGR 5230 Analyzer, it must be in EIB mode. In EIB mode, most of these tasks are
performed using the analyzer. Appendix B describes how to configure a module to operate in
one mode or the other.

The following assumes that the module is to be used in stand-alone mode. The tasks
available for NOXCAN* modules are listed in Table 1.
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Change Node ID: Allowable range 0x01 to 0x7F (hex). When you assign a Node 1D (NID),
the following CAN IDs cannot be used by any other devices on the bus:
0x00, 0x80 + NID, 0x180 + NID, 0x280 + NID, 0x380 + NID, 0x480 + NID,
0x580 + NID, 0x600 + NID, 0x700 + NID, Ox7E4, OX7E5.

View Module Information: Manufacturer’s Name, Hardware Version, Software Version

Set Broadcast Rate: All activated TPDOs are transmitted every “n” milliseconds. “n” can
be programmed. 5 ms is the minimum. Default: 5 ms.
Set Averaging Filters: Before the data is transmitted by the module (at the broadcast rate), it
can be averaged. There are three averaging filters (alphas): one for NOx (i.e. NOx,
IP2, IP2X, IP2R, IP3), one for Lambda (i.e. O2R, IP1, IP1X, IP1R, LAMR, AFR,
PHI, FAR, LAM, 02), and one for Pressure (i.e. PR16, PR10, PCF, P, PVLT, PKPA,
P, PVLT, PKPA, PBAR, PPSI). Alphas can range from 0.001 to 1 and are used in the
recursive averaging filter: AvgData; = alpha x Data; + (1l-alpha) x AvgData;;.
Where: AvgData; is the transmitted data at time “t”.
AvgData; is the previously transmitted data.
Datat is the raw data at time “t”.

This formula is executed every 5 ms regardless of broadcast rate. Note that if alpha =
1, there is no averaging and the data taken at time “t” becomes the average value at
time “t” and hence the broadcast value. Default Alpha values: 0.375.

Enter Fuel Constants: H:C, O:C, and N:C ratios or if the fuel is H2. Defaults: H:C = 1.85,
O C=0,N:C=0

Enter Pressure Sensor Constants: N and C are the gain and offset of the pressure sensor.
N and C are written on a label attached to the pressure sensor. P (psia) = N x (V - C).
V = voltage from sensor.

Span O2: User enters displayed %02 (TPDO data) and the actual %02 of the span gas.
This is how you calibrate the O2 (AFR, Lambda, PHI, FAR) measurement
function of the NOx sensor.

Zero NOXx: User enters displayed NOx value (TPDO data) and the actual NOx value of the
“zero” gas. Zero gas does not necessarily have to be exactly zero. A non-zero value
can be entered.

Span NOx: User enters displayed NOx value (TPDO data) and the actual NOx value of the
gas. Preferentially Span near the upper NOx value to be measured.

Lambda/O2 Delta Tables: These tables are used to modify the calculated O2 and Lambda
(and hence AFR, FAR, and PHI). There are two tables. The first, the Delta O2 Table,
allows modification of the calculated %02 via a user-entered look-up table. Delta O2
Table entries will not influence Lambda, AFR, FAR or PHI values. The second, the
Delta Lambda Table, allows modification of the calculated Lambda (and hence AFR,
FAR, and PHI) via a user-entered look-up table. The Delta Lambda table will not
influence O2 values. See Appendix C.

Select NOx Curve (NOxXCANg only): Match engine (wet) data or model gas data.

Set NOx Gamma/Beta (NOXCANg only): User enters parameters for O2 compensation.

Hardware Reset: Equivalent to powering the module down then up again.

Reset TPDOs to Factory Settings: These are the parameters displayed and transmitted.
TPDO stands for Transmit Process Data Object.

Toggle Sensor Settings: Allows power to ceramic sensor to be turned on and off and enables
rapid sensor warm-up scheduling (Default: On (fast)).

Toggle Pressure Compensation: Enable and disable pressure compensation of O2 (Lambda,
AFR, FAR, PHI) and NOx data. Defaults: On.

Toggle TPDO CAN ID Auto Set: Enable and disable TPDO CAN ID Auto Set. Default: En.

Table 1: Task List for NOxXCAN* Modules



Calibration of the NOx Sensors

Ceramic NOx sensors operate on a diffusion mechanism. Molecules leaving the combustion
chamber diffuse through passages into the sensor where oxidation, oxygen pumping, and
oxygen stripping occurs. Diffusion passages are like filters and can get clogged. In fact, it is
impossible to avoid clogging when the sensor is being used. The clogging of diffusion
passages is the main mechanism by which a sensor “ages” resulting in a calibration shift.

Sensors shipped with NOXCAN* modules have been calibrated (i.e. zeroed and spanned)
before leaving the factory. It is recommended that they be calibrated periodically during use.
How often can only be determined by your experience. Alternatively, sensors can be sent to
ECM for recalibration.

Calibration information (both factory calibration and user calibration) for the NOx sensors is
stored in a memory chip in the sensor’s connector. Therefore, the sensor does not have to be
used with the module it was calibrated with. Once calibrated, the sensor can be sent to
another site to be used. After use, the sensor can be returned to the calibration center for
recalibration thus compensating for any sensor aging. Centralization of calibration in this
way improves measurement consistency and extends useful sensor life.

Calibration should be performed in this order: Span O2, Zero NOx, Span NOx. The
sensor does not require the “Zero O2” task.

Span O2 for NOXCANt, NOXCANg, and the Original NOXCAN

The “Span O2” task in the Configuration Tool calibrates both the %02 and Lambda (AFR,
FAR, PHI) measurements of the sensor. To perform an O2 span:

1. The NOx sensor and pressure sensor (if so equipped) should on for at least 20
minutes.

2. Hang the NOx sensor and the pressure sensor (if equipped) in ambient, stationary air.
The pressure is required during calibration if the sensor’s %02 and Lambda (AFR,
FAR, PHI) measurements are to be pressure compensated.

3. Calculate the %02 in the air. The %02 in air with no humidity is 20.945. This
percentage decreases with increasing humidity. To calculate the %02 in non-zero
humidity air, use the “Calculate %02 in Air” tool in the Configuration Tool. 20.7 is a
common number.

4. Select O2 as a TPDO parameter.

5. Select the Task “Span O2”. Enter the displayed O2 (the TPDO parameter) and the
actual %02 (as calculated in 3 above), then click on “Span”.




& Delta O2 Table and Delta Lambda Table

The %02 calculated by NOXCAN* modules is denoted as “O2R” and is a wet (i.e. water
taken into consideration in %02 calculation), at chemical-equilibrium (i.e. not frozen-
equilibrium) %02 measurement (see Appendix C). The Lambda (AFR, FAR, PHI)
calculated by NOXCAN* modules is denoted as “LAMR” and matches that calculated by
mass flowrates of air and fuel entering the engine.

Sometimes users would like dry %02 readings, or frozen-equilibrium %02 readings, or dry
frozen-equilibrium readings, or readings that match another instrument. For this purpose, the
Delta O2 Table is used. The Delta O2 Table (found in the “Lambda/O2 Delta Tables” task)
allows the user to add a number (a “delta”) to the “O2R” calculated by the NOxCAN*
modules giving the “O2” parameter:

02 = O2R + Delta O2 Table value (interpolated from table)*
* except when O2R > 18 for which O2 = O2R, regardless of table data.

A Delta O2 Table can be created, edited, and saved as a text file (.txt) on your PC. The file
must be downloaded into the NOXCAN* module for it to be used. Unlike the sensor
calibration information (i.e. zero, span) which is stored in a memory chip in the sensor’s
connector, the Delta O2 Table is stored in the module.
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Similarly, sometimes users would like Lambda (AFR, FAR, PHI) readings to match other
instruments such as gas-bench analyzer calculated values (ex. via Spindt or Brettschneider) or
company “heritage” Lambda measurement techniques. The Delta Lambda Table (found in
the “Lambda/O2 Delta Tables” task) allows to user to add a number (a “delta”) to “LAMR”
calculated by the NOXCAN* modules giving the “LAM” parameter:

LAM = LAMR + Delta Lambda Table value (interpolated from table)

AFR, FAR, and PHI are calculated from “LAM”. A Delta Lambda Table can be created,
edited, and saved as a text file (.txt) on your PC. The file must be downloaded into the
NOxXCAN* module where it is used. File LA42.TXT (for LSU4.2 sensor) or file LA49.TXT
(for LSU4.9 sensor) can be downloaded to make NOXCAN* modules match default ETAS
LA4 data (see Appendix C). Unlike the sensor calibration information (i.e. zero, span) which
is stored in a memory chip in the sensor’s connector, the Delta Lambda Table is stored in the
module.

Zero and Span NOx for NOXCANt and NOxCANg

The following applies to the calibration of the NOXCANt and NOXCANGg kits only. For the
calibration of the original NOXCAN Kit, refer to the next section.

Calibration should be performed in this order: Span O2, Zero NOx, Span NOX.

It is important to realize that when in the exhaust of a running engine, the NOx sensor is
seeing water vapor. Therefore it will report “wet” %02 and NOx ppm numbers. Classical
gas analysis equipment (ex. NOx Chemiluminescent Analyzer (CLA)) typically have the
water removed from the gases before they reach the analyzer. Thus classical gas analysis
equipment will report “dry” numbers which are greater than “wet” numbers. When
comparing “wet” to “dry” numbers make sure to compensate for the removed water.

The Zero NOx and Span NOx tasks can be performed either using model gases or in a
running engine. Model gases are mixtures of NOx, O2, and N2 from bottled tanks that have
been bubbled through water before reaching the sensor.

& Calibrating Using Model Gases
When calibrating the NOx sensor using model gases, the recommended procedure is:

1. The NOx sensor and pressure sensor (if so equipped) should on for at least 20
minutes.

2. Hang the NOx sensor and the pressure sensor (if equipped) in ambient, stationary air.

The pressure is required during calibration if the sensor’s NOx measurements are to

be pressure compensated.

(For NOXCANg Only): Select “Model Gas” in the task “Select NOx Curve”.

4. (For NOXCANg Only): There are four O2 compensation parameters (two gammas,
and two betas) that affect the calculated NOx. One set of gamma, beta is used for the
engine NOx calculation and the other for the model gas NOx calculation. These

.



9.

numbers are factory-set to nominal values, stored in the sensor’s memory chip, and
should not be changed without contacting ECM.

Perform the “Span O2” task if not performed earlier.

Perform the “Zero NOx” task with the NOx sensor and pressure sensor (if so
equipped) hanging in ambient, stationary air (i.e. same condition as “Span O2”).
IMPORTANT NOTE: Do not zero in pure N2 or N2 that has been bubbled through
water! This will damage the NOx sensor.

Perform the “Span NOx” task with the NOx sensor mounted in a vessel. The pressure
sensor should be measuring the pressure in the vessel if the NOx measurements are to
be pressure compensated. Use the supplied pressure line assembly to avoid
overheating the pressure sensor. Flow gases of the composition NO + 02
(approximately 20%) + N2 (balance) through a bubbler and through the vessel
containing the NOx sensor. The NO concentration (ppm) should be close to the
maximum ppm that is expected in the engine. IMPORTANT NOTE: Do not span in
a mixture that contains less than 1% O2! Use approximately 20% O2 for best
calibration. The flowrate should be less than 5 Ipm.

Correct the span NOx ppm content of the gas for water vapor using the formula:

NOx (corrected) = NOx (before bubbler) x ((%02 in air)/20.945)

where: “%02 in air” is determined using the “Calculate %02 in Air” tool with
Rh=100%, the pressure in the bubbler, and the water temperature in the
bubbler.

IMPORTANT NOTE: We have found that the best calibration is performed based
on measured NOx data from a NOx CLA sampling from the vessel holding the NOx
sensor (i.e. not using the above formula). We believe that this is because of reactions
that occur in the lines from the model gas tanks to the sensor.

“Span NOx” when the displayed NOx (the TPDO parameter) is stable.

10. (For NOXCANg Only): Select “Engine” in the task “Select NOx Curve” before using

the NOx sensor in an engine.

& Calibrating Using Engine Gases

When calibrating the NOx sensor using engine gases, the recommended procedure is:

1.

Hold the powered NOx sensor and pressure sensor (if so equipped) in air for 20
minutes. Pressure information is required if the calibration is to be pressure
compensated.

(For NOXCANQg Only): Select “Engine” in the task “Select NOx Curve”.

(For NOXCANg Only): There are four O2 compensation parameters (two gammas,
and two betas) that affect the calculated NOx. One set of gamma, beta is used for the
engine NOx calculation and the other for the model gas NOx calculation. These
numbers are factory-set to nominal values, stored in the sensor’s memory chip, and
should not be changed without contacting ECM.

Perform the “Span O2” task if not performed earlier.

Perform the “Zero NOx” task with the NOx sensor and the pressure sensor sensing
the exhaust of a running engine and in comparison to a CLA. The pressure sensor
should be measuring the pressure in the exhaust if the NOx measurements are to be



pressure compensated. Use the supplied pressure line assembly to avoid overheating
the pressure sensor. The NOx level doesn’t have to be exactly zero for the zero
process. To get a low NOx number, the engine should not be under load and EGR
should be used. For example, if it is 12 ppm, the Configuration Tool will allow for
this. Since water is in the gases that the NOXx sensor is seeing, it is best to use a “wet”
NOx number from the CLA. If you do not do this, you are putting an error into the
measurement since %H20, and hence the difference between a “wet” and “dry”
measurement, changes with stoichiometry.

. Perform the “Span NOx” with the NOx sensor in a running engine and in comparison

to a CLA. Span at the upper range of NOx to be measured. To get a high NOx
number, the engine should be under load with no EGR. Again, it is best to use a
“wet” NOx number from the CLA.



Zero and Span NOx for the Original NOXCAN

The following applies to the calibration of the original NOxXCAN kit only. For the calibration
of a NOXCANt or NOXCANGg kit, refer to the previous section. Note that the original
NOXCAN kit has been replaced by the NOxCAN kit.

Calibration should be performed in this order: Span O2, Zero NOx, Span NOx.

It is important to realize that when in the exhaust of a running engine, the NOx sensor is
seeing water vapor. Therefore it will report “wet” %02 and NOx ppm numbers. Classical
gas analysis equipment (ex. NOx Chemiluminescent Analyzer (CLA)) typically have the
water removed from the gases before they reach the analyzer. Thus classical gas analysis
equipment will report “dry” numbers which are greater than “wet” numbers. When
comparing “wet” to “dry” numbers make sure to compensate for the removed water.

The NOx sensor in the original NOXCAN kit was designed to be used in a hot exhaust pipe.
If it is mounted in a cold sample tube, the NOx measurement response will be very slow (i.e.
hundreds of seconds). Also, the zero and gain of the NOx measurement is sensitive to
changes in the exhaust pipe’s temperature. To reduce this sensitivity, ECM offers a heated
NOx sensor mount (the BTU200). With or without the BTUZ200, for best accuracy the NOx
sensor should be calibrated in a mounting pipe and with the pipe temperature similar to that it
will be used at.

The gases the NOx sensor is measuring must contain water. Since the combustion of
hydrocarbon fuels produces approximately 2 to 12% water (depending on fuel type and
Lambda), this is not a problem unless the sensor is placed after a water separator. Also, for
best accuracy, the NOx sensor should be calibrated in gases with approximately the same
amount of water vapor as is in the exhaust it will be measuring.

When the NOx sensor is off (i.e. cold) and is stored for a period longer than a few days, the
sensor may adsorb water vapor. This results in a NOx measurement error until the water is
evaporated off the sensor. When the sensor is used in an engine, this will occur quickly.
However, if the sensor is held in air or is mounted in a cold pipe with slow moving gases, it
may take up to eight hours for the water to evaporate off.

To minimize above-described effects, it is strongly recommended that the NOx zero and span
be performed with the NOx sensor mounted in the exhaust of a running engine and in
comparison to a CLA. It is not recommended that the NOx sensor be calibrated using the
CLA’s zero and span gases (i.e. “model gases”) because the NOx sensor will be mounted in a
cold tube during this calibration and water vapor will not be present in suitable quantities in
the calibration gases.

Therefore, the recommended calibration procedure for the original NOXCAN and uses engine
gases.
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@ Calibrating Using Engine Gases (Recommended for Original NOXCAN)

1. Hold the powered NOx sensor and pressure sensor (if so equipped) in air for eight
hours. This is to remove any adsorbed water. Pressure information is required if the
calibration is to be pressure compensated.

2. Perform the “Span O2” task if not performed earlier.

3. Perform the “Zero NOx” task with the NOx sensor and the pressure sensor sensing
the exhaust of a running engine and in comparison to a CLA. The pressure sensor
should be measuring the pressure in the exhaust if the NOx measurements are to be
pressure compensated. Use the supplied pressure line assembly to avoid overheating
the pressure sensor. The NOx level doesn’t have to be exactly zero for the zero
process. To get a low NOx number, the engine should not be under load and EGR
should be used. For example, if it is 12 ppm, the Configuration Tool will allow for
this. Since water is in the gases that the NOx sensor is seeing, it is best to use a “wet”
NOx number from the CLA. If you do not do this, you are putting an error into the
measurement since %H20, and hence the difference between a “wet” and “dry”
measurement, changes with stoichiometry.

4. Perform the “Span NOx” with the NOx sensor in a running engine and in comparison
to a CLA. Span at the upper range of NOx to be measured. To get a high NOx
number, the engine should be under load with no EGR. Again, it is best to use a
“wet” NOx number from the CLA.

@ Calibrating Using Model Gases (Not Recommended for Original NOXCAN)

If a NOx CLA is not available, the back-up calibration procedure for the NOx sensor used in
the original NOXCAN is:

1. Hold the powered NOx sensor and pressure sensor (if so equipped) in air for eight
hours. This is to remove any adsorbed water. Pressure information is required if the
calibration is to be pressure compensated.

2. Perform the “Span O2” task if not performed earlier.

3. Mount the NOx sensor in a BTU200 heater or in a tube heated to the temperature of
the exhaust pipe that the sensor will be used in.

4. Perform the “Zero NOx” task with the NOx sensor and pressure sensor (if so
equipped) exposed to ambient, stationary air. IMPORTANT NOTE: Do not zero in
pure N2 or N2 that has been bubbled through water! This will damage the NOx
sensor.

5. Perform the “Span NOx” task with the NOx sensor mounted in a vessel and in the
same heated condition as during “Zero NOx”. The pressure sensor should be
measuring the pressure in the vessel if the NOx measurements are to be pressure
compensated. Use the supplied pressure line assembly to avoid overheating the
pressure sensor. Flow gases of the composition NO + O2 (approximately 20%) + N2
(balance) through a bubbler and through the vessel containing the NOx sensor. The
NO concentration (ppm) should be close to the maximum ppm that is expected in the
engine. IMPORTANT NOTE: Do not span in a mixture that contains less than 1%
02! Use approximately 20% O2 for best calibration. The flowrate should be less
than 5 Ipm.
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6. Correct the span NOx ppm content of the gas for water vapor using the formula:

NOX (corrected) = NOx (before bubbler) x ((2602 in air)/20.945)

where: “%02 in air” is determined using the “Calculate %02 in Air” tool with
Rh=100%, the pressure in the bubbler, and the water temperature in the
bubbler.

IMPORTANT NOTE: We have found that the best calibration is performed based
on measured NOx data from a NOx CLA sampling from the vessel holding the NOx
sensor (i.e. not using the above formula). We believe that this is because of reactions
that occur in the lines from the model gas tanks to the sensor.

7. “Span NOx” when the displayed NOX (the TPDO parameter) is stable.
The following conditions may result in inaccurate NOXx readings:

1. If the NOx sensor is not held in air for eight hours (while powered) prior to
calibration.

2. If a BTU200 is not used or if the pipe the sensor is mounted in during calibration is
not heated.

3. If the calibration model gases are not bubbled through water.

4. If the calibration model gases change composition while flowing from the tanks to the
sensor.

5. If the NOx sensor is subsequently used in an unheated sample line.

6. If the NOx sensor subsequently measures exhaust gases after these gases have passed
through a water separator.

IMPORTANT NOTE: ECM has found it very difficult to accurately calibrate the original
NOXxCAN NOx sensor using model gases. Calibrate in an engine and in comparison to a
NOx CLA if possible or send the NOx sensor back to ECM for calibration.
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Selecting What Data is to be Sent (TPDOS)

Data send from NOXCAN* modules is packaged as TPDOs (Transmit Process Data Object).
Each TPDO contains two pieces of data and each module can send up to four TPDOs. All
selected TPDOs will be sent at the broadcast rate. For example, if the broadcast rate is 5 ms
and four TPDOs were selected to be sent, then eight pieces of data would be transmitted
every 5 ms. To avoid slowing down the effective data rate on the CAN bus, select the
number of TPDOs to be sent and the broadcast rate sparingly. For the case of multiple
modules sending multiple TPDOs on the same CAN bus, the minimum (i.e. fastest) broadcast
rate is given by:

Minimum Broadcast rate (ms) = The total number of TPDOs for all modules x 0.3125

For example, if there are eight modules, each sending two TPDOs, the minimum broadcast
rate is 5 ms.

The data transmitted is selected in the “Data” area of the Configuration Tool. Activate the
number of TPDOs to be used by clicking in its box to put in a check mark. Select the data
contained in each TPDO using the pull-down windows. The list of available parameters for
the NOXCAN* module is given in Table 2.

Note that in the parameter list, there are two Lambdas: LAMR (Lambda Real) and LAM
(Lambda).

LAMR is the Lambda value calculated by the module.

LAM is the Lambda value calculated by the module and modified by the Delta Lambda Table
according to the relationship:

LAM = LAMR + Delta Lambda Table value (interpolated from table)
The modified LAM (Lambda) will also influence AFR, FAR, and PHI.
Similarly for O2R and O2:
02 = O2R + Delta O2 Table value (interpolated from table)*

* except when O2R > 18 for which O2 = O2R, regardless of table data.
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Parameter

Name

Displayed Full Parameter Name Parameter Description

NOX NOX (ppm) NOXx

O2R %02real (%) %02 before addition of Delta O2 Table

IP1 Ipl (nA) Pressure-compensated Ip1 sensor pumping current

P2 Ip2 (nA) Pressure-compensated Ip2 sensor pumping current

RPVS RPVS (Ohms) NOx sensor internal V'S cell resistance

VHCM VH Commanded (V) Desired heater voltage commanded by the module

VS VS (V) NOx sensor internal VS cell voltage

VP1P VP1+ (V) NOx sensor Ip1 pumping voltage

VP2 VP2 (V) NOx sensor Ip2 pumping voltage

VSW Vsw (V), not used for NOXCANg Supply voltage measured at the module

VH VH Measured (V) Actual heater voltage at the module

TEMP Circuit Board Temp (°C) Temperature of the module circuit board

IP1R Iplraw (bits) NOXx sensor Ip1 pumping current (unsigned integer format)
IP2R Ip2raw (bits) NOXx sensor I1p2 pumping current (unsigned integer format)
ERFL Error bit flags (bits) Module error flags (unsigned long format)

ERCd ECM CANOpen Error Code ECM CANOpen Error Code

PR10 Praw10 (bits) 10 bit Pressure sensor output voltage (unsigned integer format)
PCE Pressure Correction Eactor ll\loc()))(() gensor Ip1 pressure compensation correction factor x
PCFE ECM diagnostic parameter

O2E ECM diagnostic parameter

IP1E ECM diagnostic parameter

PE ECM diagnostic parameter

P P (mmHg) Pressure sensor measured pressure (absolute) in mmHg
LAMR LAMBDAreal Lambda before addition of Delta Lambda Table

AFR Air-Fuel Ratio Air-Fuel ratio calculated using LAMBDA (see below)

PHI PHI PHI = 1/LAMBDA

FAR FAR*10000 FAR = (1/AFR) * 10000

LAM LAMBDA Lambda after addition of Delta Lambda Table

02 02 (%) %02 after addition of Delta O2 Table

IP1X Ip1 non Pcomp (mMA) Non-pressure compensated NOX sensor Ipl pumping current
PVLT P (V) Raw volts from pressure sensor

PKPA P (kPa) Pressure sensor measured pressure (absolute) in kPa
PBAR P (bar) Pressure sensor measured pressure (absolute) in bar

PPSI P (psi) Pressure sensor measured pressure (absolute) in psi

IP3 Ip3 (nA), NOxCANg only NOx sensor 1p3 pumping current

IP2X :\? éQSnAEZO;?% (I\LILQ(C ANt only Non-pressure compensated NOX sensor 1p2 pumping current
NCE NOx Pressure Correction Factor, NOx sensor Ip2 pressure compensation correction factor x

NOxCANg and NOxCANTt only

10000
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Producing a .dbc File

A .dbc file describes to the device receiving data from one or more *CAN modules what is in
the data packages. For each module, the packages will contain data for the parameters
selected in the activated TPDOs and an error code. The Configuration Tool has a tool called
“Generate .dbc...” that will generate a .dbc file for all the *CAN modules on a CAN bus.
Make sure that each module is configured as desired and that all modules are on the bus
before the “Generate .dbc...” button is pushed. Data package information from all the
modules is stored in the one .dbc file produced.

Programs importing the .dbc file and applying it to the CAN data transmitted by the modules
will see data, etc identified as follows:

Data: name_nid[units]
where: name = parameter name. See Table 2.
nid = node id of module in hex
units = units of parameter
for example: O2_0X01[%] which is the %02 measured by module with nid 0X01
Error code: ECM_Error_Code _nid

where nid = node id of module hex
error code is in hex and given in Table 3

for example: ECM_Error_Code_0x11
Auxiliary: ECM_Auxiliary _time[sec]
where: time = decrementing countdown to module activation in hex

for example: ECM_Auxiliary_0X12[sec]

15




ECM ERROR

CODE LED ACTION DESCRIPTION OF ERRORS

0x0000 Grn ON All OK, (green led constantly on)

0x0001 Flash Grn 10Hz Sensor warm-up period

0x0002 Grn/Both/Red 2s |Power on reset/ Init hardware

0x0011 Pulse Red 1x/2s |l6b ADC failed to init

0x0012 Pulse Red 1x/2s |+Vsw shorted

0x0013 Red ON Sensor turned off (red led constantly on)

0x0014 Pulse Red 1x/2s |HTR open

0x0015 Pulse Red 1x/2s |HTR shorted

0x0021 Pulse Red 2x/2s |lwire bus shorted

0x0022 Pulse Red 2x/2s |[No lwire present

0x0023 Pulse Red 2x/2s |CRC16 error

0x0024 Pulse Red 2x/2s |Invalid lwire parameter (sensor type)

0x0025 Pulse Red 2x/2s |l-wire data format not compatible (old rev)

0x0031 Pulse Red 3x/2s [+Vsw < 6 for > 7sec

0x0032 Pulse Red 3x/2s |+Vsw > 30V

0x0041 Pulse Red 4x/2s |VS too high

0x0051 Pulse Red 5x/2s |RVS too high

0x0052 Pulse Red 5x/2s |(VHcommanded - VHactual) > 0.5V for > 1l0sec

0x0061 Pulse Red 6x/2s |[VP+ > 6V

0x0062 Pulse Red 6x/2s |[VP+ < 2V

0x0063 Pulse Red 6x/2s |VP2 out of range (NOxCAN* only)

0x0064 Pulse Red 6x/2s |0.15V > VS+ > 0.75V for 7.5 sec.

0x0065 Pulse Red 6x/2s |User data (span) in lwire corrupted (user must set new
span)

0x00A1 N/A Invalid software state

0x00B1 N/A CAN overrun

0x00B2 N/A CAN passive mode

0x00B3 N/A CAN heartbeat error

0x00B4 N/A CAN recover bus off

0x00B5 N/A CAN Tx CanId collision

0x00B6 N/A Serial overrun

0x00FF Both ON Module powering down within 500ms

ECM AUX N/A Sensor Warm-up count down in seconds (active during ECM

Error Code 0x0001)
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Using the dashCAN™* Display

The dashCAN display (see cover and below) is a small (105 mm x 63 mm x 63 mm), display
for CAN networks containing ECM *CAN modules. dashCAN+ is a slightly larger display
(105 mm x 63 mm x 165 mm) with the addition of six programmable analog outputs.
dashCAN* (i.e. dashCAN or dashCAN+) comes with a two meter cable and a “T” (P/N 09-
05). Simply attach dashCAN* to the CAN bus and parameters from two ECM *CAN
modules can be displayed and converted to analog outputs (dashCAN+ only). The top
display and analog outputs 1, 2, and 3 can be assigned to one module and the bottom display
and analog outputs 4, 5, and 6 can be assigned to the same or another module. Multiple
dashCAN™ displays can be attached to the CAN bus.

dashCAN* has two modes of operation: RUN (when measurements are displayed) and SYS
(where dashCAN™ is set-up). The SYS key toggles between the modes.

While in RUN mode:

i. If the T button is pressed, the displays will show the serial numbers of the modules
assigned to the displays (a module is assigned to the top display and analog outputs 1, 2, 3
and a module is assigned to the bottom display and analog outputs 4, 5, 6).

ii. If the { button is pressed, the displays will show the parameter names assigned to the
displays. See Table 2.

iii. If the ENT button is pressed, the displays will show the units of the parameters.
“PCTG” is %. “dIM” means dimensionless (ex. for AFR, FAR, PHI, Lambda).

In RUN mode, four things other than data can be displayed:
1. “ERR” and “####” where “####” is an error code. See Table 3.

1. “....” which means that a module has not been assigned to that display.
iii. “----“ which means that dashCAN* has an internal problem.
v. “XXXX” which means that dashCAN* is not receiving any data from the module

assigned to that display.

When first entering SYS mode, either “MOd” will be on the top display or “LOCK” will be
on the bottom display. If “MOd” is displayed, the T and { keys will roll through the setup
options (see Table 4). First the options for the module assigned to the top display are shown
on the top display, followed by identical options for the module assigned to the bottom
display, ending with the global CONF (Configuration) setup. Pressing the ENT key will
select the displayed setup option and allow its programming.

If “LOCK?” is displayed, the dashCAN* has been locked and its setup cannot be changed until
it is unlocked. Appendix F describes how to LOCK and unlock dashCAN*.

dashCAN
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Setup Option Level 1 Function

MOd Select module s/n to be assigned to the display. Default is NONE.

RATE Set parameter averaging rate. Range 0.001 to 1.000
Default is 1.000. 1.000 means no averaging.

AOUT (dashCAN+ only)
Al Program analog output 1 from module assigned to top display
A2 Program analog output 2 from module assigned to top display
A3 Program analog output 3 from module assigned to top display
A4 Program analog output 4 from module assigned to bottom display
A5 Program analog output 5 from module assigned to bottom display
A6 Program analog output 6 from module assigned to bottom display

dISP Select parameter. Note: Parameters available are those
contained in TPDOs programmed to be transmitted from
the module (programmed using the Configuration Tool).

CONF LEdS Set display intensity. Default is 3333.
LOCK Lock and Unlock Display for Programming

MOd, RATE, AOUT, and dISP appear on the top display for the module assigned to the top
display and then on the bottom display for the module assigned to the bottom display. CONF
just appears on the bottom display and is for global dashCAN* setup. All entries must be
followed by pressing the ENT key.

Table 4: Menu Tree for dashCAN~*

MOd (Module) Setup Option

In MOd setup, the serial number of the module assigned to the top or bottom display is
entered. The serial number is written on a label on the module. The module assigned to the
top display will be assigned analog outputs 1, 2, and 3. The module assigned to the bottom
display will be assigned analog outputs 4, 5, and 6. The same module can be assigned to both
displays or different modules can be assigned to each display.

After entering MOd (i.e. press ENT when “MOd” is displayed), the serial numbers of the
available modules will be displayed. Select using T and { followed by the ENT key.

RATE Setup Option

Data is transmitted from modules at the broadcast rate and the programmed averaging that
was programmed using the Configuration Tool. This transmitted data can then be further
averaged before being displayed on the displays. Separate averaging can be programmed for
the top display and the bottom display. RATE does not affect the analog outputs.

The averaging is programmed with values from 0.001 (heavy averaging) to 1.000 (no
averaging). The default is 1.000. The averaging is performed as follows:

DisplayedValue; = o x Parameter; + (1 — a) x DisplayedValue;;
where:
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DisplayedValue; = the new displayed value

a = The user-programmable averaging.
Range: 0.001 (heavy averaging) to 1.000 (no averaging).

Parameter; = the latest value transmitted by the module

DisplayedValue.; = the previous displayed value

AOUT (Analog Outputs) Setup Option (dashCAN+ Only)

The dashCAN+ display head has six 0 to 5V programmable analog outputs. The analog
outputs are updated at the module Broadcast Rate (see Table 1). This can be as fast as every

5 ms.

Keep in mind that the data may be averaged (see Set Averaging Filters in Table 1)

before being broadcast by the module but it is not averaged by the display.

Parameter information from the module assigned to the top display (see MOd) can be sent to
analog outputs 1, 2, and 3. Parameter information from the module assigned to the bottom
display can be sent to analog outputs 4, 5, and 6. Only parameters selected as active TPDOs
for that module (using the Configuration Tool) can be output.

Here is an example of setting analog output 2 (i.e. A2):

6.
7.

o r wheE

Press the SYS key so that “MOd” appears on the top display.

Press the | key until “AOUT” is on the top display. Then press the ENT key.

Press the 4 key until “A2” (analog output 2) is on the display. Then press the ENT
key.

Press the T and 4 key until the parameter (see Table 2) that will drive A2 is displayed.
Then press the ENT key.

When 0V is displayed, press ENT. Using the T, ¥, and ENT keys, set the parameter
value that you want to result in an analog output voltage of OV on analog output 2.
The first time you do this, it may be a little tricky. You are setting one digit at a time
and for some numbers, the display will shift to the left so you can set the right-most
digits. If you get into trouble when programming, press the SYS key twice to exit and
re-enter setup to try again.

When 5V is displayed, press ENT. Using the T, ¥, and ENT keys, set the parameter
value that you want to result in an analog output voltage of 5V on analog output 2.
When “AOUT” is displayed, press SYS to return to RUN mode.

If in the above example analog output 4 was being programmed, AOUT, A4, 0V, 5V, and
your entries would be shown on the bottom display.
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dISP (Display) Setup Option

The dashCAN~* display head has two displays, the top display and the bottom display.

In dISP setup, a parameter from the module assigned to the display (see MOd) can be shown
on the display. Only parameters selected as active TBDOs for that module (using the
Configuration Tool) can be displayed.

Here is an example of setting the parameter to be displayed on the top display:

1. Press the SYS key so that “MOd” is displayed.

2. Press the 4 key until “dISP” is on the top display. Then press the ENT key.

3. Press the T and 4 key until desired parameter name is displayed. See Table 2. Then
press the ENT key.

4. Press SYS to return to RUN mode.

CONF (Configure) Setup Option

CONF setup appears at the end of the setup list on the bottom display. To enter CONF, press
the SYS key so that “MOd” appears on the top display, press the | key until “CONF” appears
on the bottom display, and then press the ENT key. CONF is for global dashCAN™* setup.

& LEdS

The display intensity is programmable. Press the ENT key when “LEdS” appears on the
bottom display, press the T or { keys until the display intensity is suitable, press ENT, and
press SYS to return to RUN mode.

¢ LOCK

“LOCK” locks the MOd, RATE, AOUT, dISP, and LEdS setup. This stops unauthorized
modification of the display. Refer to Appendix F for more information.
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Appendix A: NOXCAN* Kit Contents

S P/N 09-06
X
P/N 09-05 |
~_ 6“

— P/N 09-04

P/N 02-07 (NOxCANTY) or
P/N 02-03 (NOxCANg) or
P/N 02-01 (NOxCAN)

P/N 11-02

__— Optional Pressure
Compensation

P/N 13-01

P ey e s e e s

P/N 12-08A (USA)‘
\ ©°f 12-11A (metric) l

i

P/N 07-01

P/N 06-07 (NOxCANTY) or
(USA) or

P/N 06-02 (NOXxCANg) or
P/N 06-01 (NOXCAN)

e e s — — — — ——————

P/N 12-02 (NOXCANt, NOXCAN) & ./
or P/N 12-28 (NOXCANg) g R
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The NOXCAN* (NOxCANt, NOxCANg, or the Original NOxXCAN) Kit consists of:

ROoo~NOGA

11.

w

0.

Description P/N
NOxCANt Control Module or 02-07
NOxCANg Control Module or 02-03
NOxCAN Control Module 02-02
NOxt Sensor or 06-05
NOxg Sensor or 06-02
Original NOx Sensor 06-01
Inconel shield (installed on 06-01 sensor only) 12-09
NOx Extension Cable 10-02 (1m)
Flexi-Eurofast Cable 09-04 (0.3m)
Eurofast “T” 09-05
Eurofast Terminating Resistor 09-06

2m Eurofast 12mm Cable 09-02

DC Power Cable, DBIF, Banana 11-02
NOxt, NOx Sensor Boss & Plug (18mm x 1.5mm) or 12-02
NOxg Sensor Boss & Plug (20mm x 1.5mm) 12-28
Manuals and Configuration software CD 13-01

Optional Pressure Compensation (add /P to Kit part number):

Pressure Sensor, 0-75 psia, 517 kPa 07-01 (USA) or
07-02 (metric)
Pressure Sensor Tubing 12-08A (USA) or
12-11A (metric)
Pressure Extension Cable 10-04 (1m)
Module Y Cable 10-21

Optional Cables:

NOx Cable 10-03 (2m)
Pressure Cable 10-05 (2m)
DC Power Cable, DBIF, Spades 11-01

Optional Power Supplies, Heater, and CAN-to-USB Adapter:

AC/DC Power Supply, Universal 24VDC @ 4.2A 04-01
(requires P/N 11-17 Deutsch DTM3M to DB9F Cable)

Vboost Supply, 10-14VDC to 24VDC @ 14.5A 04-02
Ceramic Sensor Heater Kit (for Orig. NOxCAN only) BTU200
Kvaser Leaf Light CAN Adapter 13-02

Quantity

1
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Appendix B: Module Stand-alone Mode and EIB Mode

CAN data from *CAN modules (ex. NOXCAN, LambdaCAN) can either be taken directly
from the modules themselves or from the CAN port of display heads connected to the
modules. When data is taken directly from one or more modules, each module must in
Stand-alone mode. When data is taken from one or more display heads of an EGR 5210,
Lambda 5220, or EGR 5230 analyzer, each module must be in EIB mode.

Therefore, the module must be properly configured in Stand-alone mode or EIB mode
depending on how it will be used. When *CAN modules are sold alone, they are delivered in
Stand-alone mode. When *CAN modules are sold as part of a NOx 5210, Lambda 5220, or
EGR 5230 analyzer, they are delivered in EIB mode.

To convert from one mode to the other requires software reprogramming of the module
(using the Configuration Tool) followed by the installation (to set to Stand-alone) or removal
(to set to EIB) of a jumper inside the module.

& To convert a module from EIB to Stand-alone Mode

1. Take the nut off the end of the module. Use an 18mm socket without the wrench.
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3. Slide the PCB out. Install a jumper on JP4.

JP4

:
f

5. Slide the PCB into the enclosure until the two tangs “click”.

6. Put the nut on and tighten ONLY % turn from where it is seated. If this nut is
tightened too much, the connector will crack and the enclosure will not be sealed.

7. Connect the module to a power supply and a PC (via a CAN communication adapter)
using the cabling shown. A sensor does not have to be connected to the module.
Note that only one module is connected and a display head is not involved.



DB9F, Spades

SINPOW ‘O / BpquIeT] USdONYD
Nvoepquel DT

173a aik] ig
’\ ' v
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8
§F§

P/N 11-02, DC Power Cable, To power
Module Serial DB9F, Banana Plugs (shown), or
Number P/N 11-01, DC Power Cable,

Resistor To CAN adapter

On PC

Figure Al: Module prepared for Reprogramming

Start the Configuration Tool (software). Click on the “Module”
Select the CAN adapter being used. Then start the communication.

ez FCM Configuration Tool v3.0 Q\i@

ECM Configuration Tool

I Display Heads ]

CAN Adapter: IVectOICAN L' ICANcardX Channel 1 L’ START I Status: ]Port Closed .

Configuration ~Toals

NID  Prod# Rev# Sernialt LogData...
Madule: | 3 Generate .dbc...
Task: I Lj

Calculate %202 in Air

Manual Communication ]

Set Module Mode
ElB Stand-4lone |

Note: This function can only be
used with one module on the bus.

- Data
Sensor S/N TPDO1 | TPDO2 [~ TPDO3 I TPDO4 [~
=l I = | = | =
Emor  Aus. IU—- IU IU IU
CaNopen State :]' I ._'_] ' l.l l L'
[ o o o o

www.ecm-co.com - 408-734-3433 - Los Altos, CA, USA - (c) 2006

tab.
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10. Click on the “Set to Stand-Alone Mode”. Wait for “Done” Message.
Stop communication and exit program. The module is in Stand-alone mode.

& To convert a module from Stand-alone Mode to EIB Mode

1. Use the Configuration Tool to “Set to EIB Mode”.
2. Remove the jumper on JP4 in the lambda module.
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Appendix C: Interpreting NOXCAN* Modules

o Comparing to Spindt and Brettschneider Calculations

NOxXCAN* calculates Lambda, AFR, FAR, and PHI numbers comparable to those
determined by mass flowrates of air and fuel into the engine. Lambda calculations based on
gas-bench analyzer data (i.e. measurements of CO, CO2, etc) do not always give these same
values. This fact is well documented in the literature.

However, some organizations prefer to call their specific (and often unique) Spindt or
Brettschneider calculations of Lambda the “true” values. To satisfy such needs, ECM has
provided the Delta Lambda Table and Delta O2 Table features.

« Before and After Catalyst Measurements

The NOXx sensors operate on a diffusion mechanism. Molecules leaving the combustion
chamber (02, CO, CO2, H20, H2, HC, NOx, N2, etc) diffuse into the sensor where
oxidation, oxygen liberating, and oxygen pumping occurs. 02, Lambda, AFR, FAR, and PHI
are determined from the oxygen pumping rate and assumptions about the combustion
products entering the sensor. One such assumption is that the exhaust exists in a certain
chemical composition. Exhaust gases entering and exiting a catalytic converter have
different chemical compositions. NOxCAN* assumes that the gases are engine-out (not
catalyst-out). Therefore measurements made at the exit of a catalyst will require a Delta O2
Table and a Delta Lambda Table correction to be accurate. This is sometimes called “H2
Correction”.

« Wet versus Dry Measurements

Percentages of components in the exhaust of an engine are expressed as percentages
(molecule count or volume) or ppm. The numerator used to calculate these percentages and
ppm contains the molecule-of-interest count and the denominator contains the total number
of molecules in the sample containing the “count”. One of the molecules produced by the
process of combustion, and in significant quantities, is H20. The percentage H20 depends
on the fuel composition and Lambda but typically ranges from 2 to 12%.

Percentages and ppm calculated by NOxCAN* consider the water molecules in the
denominator and are called “wet” percentages (or ppm). This only makes sense since the
sensors are directly in the exhaust where the H20O is present. In contrast to this, classical gas-
bench analyzers almost always remove the water before the gas sample reaches the analyzers.
This is because the analyzers cannot tolerate condensed water. Therefore, gas-bench
analyzers will report O2 percentages and NOx ppms as “dry” percentages (or ppm) (i.e.
without H20 molecules counted in the denominator).
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Therefore, when comparing “wet” (or “true””) O2 and NOx data from NOxCAN* to “dry” O2
and NOx data from gas-bench analyzers, realize that the dry percentages and ppm will be 2%
to 12% higher than the wet (or true) readings. To convert from wet to dry percentages use the
formula:

Dry percentage (or ppm) = Wet percentage (or ppm) / (1 - %H20/100))
This formula assumes a 100% removal of water before the dry measurement.

For a given fuel composition, %H20 changes with Lambda (or %02). The maximum is at
stoichiometric (Lambda = 1).

« Equilibrium versus Non-Equilibrium O2

Gases exiting the combustion chamber of an Otto or Diesel cycle engine are not at chemical
equilibrium. As the exhaust valve opens, the gas temperature and pressure drop so quickly
that many chemical reactions still occurring are slowed down or “frozen” at non-equilibrium
values (for the specific temperature and pressure they are at). This degree of chemical non-
equilibrium is affected by exhaust valve timing and ignition timing. The NOXx sensor is hot
and highly catalytic and will bring the exhaust they sample closer to chemical equilibrium.
The result of this is that the %02 measured by the NOx sensor will be close to equilibrium
levels (typically 0.5% lower than actual engine-out). For example, at Lambda = 1 conditions,
the %02 reported by the NOx sensor will be 0 (the chemical equilibrium %02 value) as
opposed to the actual frozen equilibrium %02 value of approximately 0.5%. Keep this in
mind when comparing gas-bench measured %02 with NOx sensor-measured O2. This
difference can be corrected for by a Delta O2 Table.

¢ Lambda Sensor-Measured O2 versus NOx Sensor-Measured O2

Both the Lambda sensor and the NOx sensor will report %02. However, the NOXx sensor
will not measure %02 (and hence Lambda, AFR, FAR, and PHI) as accurately as the Lambda
sensor. This is because in the Lambda sensor, the electrodes measuring %02 are pure
platinum. Pure platinum electrodes give best %02 measuring performance. In the NOx
sensor, the %02 measuring electrodes have some gold in them which keeps the electrodes
from destroying the NOx in the exhaust. NOx is measured in a second set of electrodes
downstream of the %02 measuring electrodes. If the first set of electrodes were pure
platinum, the NOx would not reach the second set.

& Pressure

The main source of error influencing O2 (Lambda, AFR, FAR, PHI) measurements is exhaust
pressure.  This error is more significant the further from Lambda = 1 the exhaust
stoichiometry gets. Pressure compensation (P-comp) data is stored in the memory chip of
every NOx sensor. All that is required is the addition of a calibrated pressure sensor to the
module and the entering of the correct pressure sensor constants to activate the pressure
compensation. It is highly recommended that pressure compensation be used with any lean
burn, HCCI, or diesel engine.
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o Comparing to an ETAS LA4 Meter

Many ETAS meters with new sensors will not correctly show the %02 when the sensor is
held in air. The actual %02 in air depends on the humidity and will be almost always less
than 20.945%. Since the measurement of %02 is the fundamental mechanism by which the
wideband sensor determines Lambda, the effect that this error has on meter accuracy is
obvious. This %02 measurement error will have a negligible effect at Lambda=1 but the
effect on Lambda will increase the further Lambda gets from Lambda=1.

All lambda meters should read the correct %02 when the sensor is held in air. Due to sensor
aging and changes in ambient pressure (due to weather and altitude changes), this may not be
the case. However, NOXCAN*’s “Span O2” feature allows to user to restore the system’s
accuracy.

The O2 span is performed by holding the sensor in air and entering the actual %02 in air.
However, if you are comparing a NOXCAN* to an ETAS meter and you want the NOXCAN*
to match the ETAS meter, then you must span the NOXCAN* to whatever the ETAS meter
says the %02 is in air — even if it is wrong.

Therefore, if you want a NOXCAN* to match an ETAS meter, whether or not the ETAS
meter reads the correct %02 in air, do the following:

1. Make certain that the “LA42.TXT” (for the LSU4.2 sensor) or “LA49.TXT” (for the
LSU4.9 sensor) curve is downloaded to the NOXCAN* module as the “Delta Lambda
Table”. This is for the case of matching the “Default Curve” in the ETAS meter.
Other curves are available and the user can create his own curve.

2. Turn on the ETAS meter and hold the sensor in air. Read the %02 on the ETAS
meter. This value should be 20.945 or less since 20.945 is pure air with no humidity.
We have seen values of over 22%.

3. 02 span the NOXCAN* to the %02 given on the ETAS meter even if it is wrong.

This procedure is to be used only if you want the NOXCAN* to match a specific ETAS meter
and sensor combination. Normally, the NOXCAN™* are spanned to the correct %02 in air.
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Appendix D: Setting Up ETAS INCA for ECM Modules

Hardware Setup: Using ETAS ES591.1

Connect the power port to a power source between 6V and 32V.

Connect the Ethernet port directly to the Ethernet port on your PC. This port does not
use an internet/intranet connection like a router.

Connect either the CAN1 or CAN2 port to a CAN network (i.e. ECM modules or
display heads).

Software Setup: Using ETAS INCA V5.4.1, Hotfix 22, GM Install

30

1. Double click the INCA V5.4 icon to open the software.

2. Create a new Database. In the Database menu, select New. Give your database a

name (i.e. a folder name). In INCA, a Database means the current working directory.
Each project is created in a unique directory. When INCA is opened, it will default to
the last Database that was used.

. Add a new Workspace. Right click on the “DEFAULT” folder icon, select Add >

Workspace. You can rename it to whatever you want.

- INCA V5.4.1/22

Database Edit Yiew Options Utilities 7
D= E Xl - 0 HRERE D Y

1 Items

Add 3 Add top Folder
Add Folder Insert
Delete Delete Experiment Chrl+T
ECU-Project (aZ()... Crl+P
Copy Chrl+C COM-Configuration Alt+C
Measure-Catalog. ..
Rename Fz ECU Documentation, ..
Can-DE...
List of CAN Messages
Import Ctrb+1 Read CAN Message Log File...
Expork Chrl+E
Write: 3

Convert Experiment 3

4. Add a new dbc file for your project. Right click on the workspace you created in

step 3, select Add > Can-DB. Browse to your dbc file and click open. In this
example, we are using a file named test8mod.dbc. An INCA log window will pop up.
You can ignore this.




3 INCA V5.4.1/22

Database Edit  Wiew Options Utilities Experiment Project Device 7

DSHE »BROEX E-% & EREH D8 Y
L ttoms % INCA V5.4.1/22*
[l {ZdDEFALLT Database Edit Yiew Options  Utilities
T S 1o o = 3 g
A £ . 2
Add Folder Insett D L= E ':"% x "& |
Workspace Chriw 1 Items
Delete Delete Experiment Chrl+T —
E”t E:r::z ECU-Project (A2D. . Crlep =l {ADEFAULT
=Py ! CDM-Configuration Al+C — nod
- L4
Measure Cataloq.... gL": Workspace
Rename Fz ECU Documentation, .,
Edit Return
| List of CAN Messages
Lmport Cerk Read CAN Message Log File. ..
Export Chrl+E
Wrike 3
Convert Experiment »

5. Configure the hardware. Click on the icon for the workspace you created in step 3.
Open the Hardware Configuration icon under the section text “6. Hardware”. A
hardware configuration window will open.

IHCA

5 INCA V5.4,1/22* (=1[e3

Database Edit  ‘iew Options Utlities Experiment  Project Device 7
DEE & B0 X ## % %8 iH %I 2 & @R

1 Ikems 4 Expetiment
=) I DEFALLT Al E s X

I: B ct5mod |

S Project/device

u

=

[ Hardware/

Workspace L

3 Item comment Caonfigure hardware

(4/1/2006 3:27:24 PM 528 55

|

Filter: none | DB: <test: User: <MainUser >
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6. Select the hardware. In the hardware configuration window, right click the “HWK
Workspace” listed under the section text “1. Hardware Devices”, and select Insert.
Select the ETAS device you wish to use. In this example, we are using an ETAS
ES591.1. Expand the selection tree by clicking the “+” next to the hardware device
model. Expand the CAN selection and select CAN-Monitoring. Click OK.

. Hardware: >Workspace= Experiment: >Default<

File Hardware Device Channels Yiew 7

HOT B | e o
3E Add| handware device

1 Hardware devices
Hwl Wiorks]
orkspace Select the new modules you want to add to
the hardware configuration. —
Avvailable HY devices Cancel |

5 R ES600/ESSI0/ESSS1 Multiglcity

—E= T can {Inactive)
CAN-Monitaring; Il— :-I

= amLan —

2 can-output

fucp

cce W

= kwipz000

E=Fups

—E Ek-Line...

EheTrC

LR o T T

|2

<

7. Associate the dbc. When you clicked OK in the last step, another window will pop
up that will allow you to select a dbc that you have added to your workspace from
step 4. Expand the selection tree, select your dbc file, and click OK.

—./Hardware: >Workspace< Experiment: >Default<

File Hardware Device Channels Yiew 7

MO E A8 O e

Select project and working data for CAN-Monitoring:1

1 Hardware devices

HWE Workspace i
I?_ 555991555904’5%591’1 1 Items add ||| 41nfo —
SN: Mok assignes — = — QK
L% CAN:L =] {ZDEFALLT ~ ;l -
@CAN—Monitoring:l L =, bestEmod -
Cancel | sty e

€

Fnent F

|Can_DB... - kestamod

3 Ikem comment
(4/1/2005 3:36:10 PM 937 63)




8.

Initialize hardware. The hardware is currently stopped, as indicated by the red stop
sign icon next to the selected hardware. You must initialize it before you can use it to
collect data. Click on the Initialize Hardware button on the upper tool bar and wait
for the hardware to complete its initialization. Another window will pop up to
confirm the device to connect to. Click OK.

—'IHardware: >Workspace= Experiment: =D

Systems

i’ Connect devices...

File Hardware Device Channels Wiew ?
#o = J4dE B
1 Hard .

MOTRSpECE

ES690/ESS90/ESS21:1
SM: Mot assigned

I— CAM:

Cr-Manitaring: 1

INCA Hardware Configuration Detected Hardware e} Connected ]
1 Type:
ESE90/ESSI0JESSIL:L
Connect Shiz Not assigned 120411
Disconned 3
Disconnect all
Fiter
Info | o Cancel
HostInterfaceType System type
(@ all connected

9.

—'Hardware: >Workspace= Experiment: >Default<

Open an Experiment Environment. Click on the Experiment Environment button
on the upper tool bar to open an Experiment Environment. The Experiment
Environment is where you can setup the monitoring of the CAN bus. By default, the
Experiment Environment will be blank. You must select the variables from the dbc
file that you wish to monitor. Click on the Select Variables icon in the left hand tool

bar of the Experiment Environment.

Expetiment View Yariables Mea:

File Hardware Device Channels Wew ¥

#o = 1JME B

1 Hardware devices ,{fxperiment environmenk CtrI+F5|
HWE Workspace

iE! ESB90/ESSI0/ESSIL:1

Hor U R OW D

v,
L CAM:L Select variables.. . Shift+F4

€ Can-Manitoring: 1

-
a

33



34

10. Select and Configure Variables. Select the variables that you wish to monitor in the
Experiment Environment. These variables names are based on the data found in the
dbc file. Click Configure.

“a; Select variables <Measure variables >

Filtet ‘“ariables Selected 7

1 Devices E 3 Yariables 4 Selected already used
= Be O can-Monitaring:1 ~| | [*F0 arr_ox0r {TPDOZ_0x01-F AFR_x01
—— Bz O Emergency_0x01 &0 Canopen_Frror_Code_0x01  {Emergency_0x01-F- CANopen_Error_Code_0x01
—— B2 O Emergency_0x02 *C0 CANopen_Error_Reg_0x01  {Emergency_0x01-fr CANopen_Error_Reg_0x01
— B0 Emergency_0x03 *T0 CANopenState_0x01 {Heartbeat_0x01-f} CANopenState_0x01
—— B2 0 Emergency_0x10 €0 ECM_awsliary_0x01  {Emergency_0x01-F- ECM_Auxiliary_0x01
—— £20 Emergency_nxzo *£'0 ECM_Error_Code_0x01 {Emergency_0xO1-f} ECM_Errar_Code_0x01
— Bg O Emergency_Ox21 B0 FAR_Ox0L  {TPDOZ_Ox01-f} FAR_0x01
—— P20 Emergency_0x22 TEO LAM_ml  {TPDO1_Ox01-f} LAM_0x01
—— £20 Emergency_nxz3 Y0 0z_ox01 {TRDOL_0x0i-f} 02_0x01
— Eg O Heartbeat_0x01
— Eg O  Heartbeat_0x02
— Eg O Heartbeat_0x03
— Eg O Heartbeat_0x10
— Eg O  Heartbeat_0x20
— B2 O Heartbeat 0xz1 ™

Mo raster pre-selection possible!

Configure | Use defaults | Cancel

11. Another window will pop up to configure each selected variable. You can configure,
for each variable, whether to record or simply display the data, how the data will be
displayed (graphs, charts, gauges, numeric, etc.). When complete, click OK. We
have left all configurations at default for this example.

i Configure Selected Yariables |zl@@

Components  Filker  Parameters

2 Parameters

Parameter I
Mame Stabe dT =7 ‘window Display type Device
AFR_0x01 Dispfrac Layer_1>»<Meas.> Murn ZAM-Monitoring: 1
CAMopen_Error_Code Dispfrec Layer_1=x<Meas. = Murn ZAM-Monitoring: 1
CAMopen_Error_Req. Dispfrec Layer_1=x<Meas.= Mum CAN-Monitoring: 1
CAMopenState_0x01 Dispfrec Layer_1=x<Meas.= Mum CAN-Monitoring: 1
ECM_Auxiliary_0x01  Dispfrec Layer_1=»<Meas.= Mum CAN-Monitoring: 1
ECM_Errar_tCode_0x( Disp/rec Layer_1=»<Meas.= Mum CAN-Monitoring: 1
FAR_Ox01 Dispfrec Layer_1=»<Meas. = Mum CAN-Monitoring: 1
LaM_0x01 Dispfrec Layer_1=»<Meas. = Mum CAN-Monitoring: 1
0Z_0x01 Disp/rec .Layer_1=><Meas.> ’—L| CAN-Monitoring: 1

Active Component: <Experiment:=  |Active Filter: <all Types= |Active Parameter: <OZ_0x01=

QK Cancel

12. A new sub-window will be added to the Experiment Environment. You do not need
to select all the variables you want to monitor all at once. You can click on the Select
Variables icon again at a later time to add more variables. Each set of variables you
add will be placed in a new sub-window unless it is configured to join an existing
sub-window. In this example, we have created a sub-window for each of the eight
modules in the dbc file.



Experiment: >NewExp= Hardware: >Workspace<

Experiment Yiew Varjables Measurement Hardware Dataset Components tindow 2

D | re—" B[] 2] Measure window [+ 8| |8 Measure windo =
z 02_0x01 [ - 126 Q2R _0x10 I - [ 126] O2_0x22 ] - 13%]
— | AFR_Dn01 I -In CAMopen_Error_Reg_0x10 | [thex) | AFR_Dx22 ] -lo
g CAMopen_Error_Code_0x01 H -H[hex] CANDpen_Errcr_Code_DxWD[l -ﬂ[hex] CANDpen_Errcr_Code_Dx22|l —H[hex]
; CANopen_Error_Reg_0x01 H = H [hex] CAMNopenState_0x10 [l -|| [hex] CAMopen_Error_Reg_0x22 || —H [hex]
. | SANorenstate o1 | -lihed | ECM_Awdliary_0x10 [ -|ihed | CANopenState_0xz2 I - thex
| Eoh Adliany Dl | “|ihed | ECM Error_Code_0x10 [ Jihed | ECM_Ausdliary_0x22 I - thex
3: ECM_Error_Code_ 0w | Jiheq fiP1_oxi0 [ |ima] | ECM Error_Cods_0x22 I - thex
mm | FAR_0:01 | o P2 010 [ [ wal FAR_ =22 I o
o llLani o [ o WO _0x10 I Jippm) [fLar mx22 I B [
y L do | %] Measure windo =] =] Measure window [3 =)
e | O2_0x02 I - 12%] 0z_0x20 I - 12] AFR_0x23 I -|n
Il | AFR D2 | -To AFR_ 0520 [ -To CARNopen_Error_Code_0x23 | -|thex
2] CAMNopen_Error_Code_0x02 H fﬂ[hex] CAMopen_Error_Code_0x20 [l fﬂ[hex] CAMopen_Error_Reg_0x23 |] ﬂ[hex]
g CAMNopen_Error_Reg_0x02 H = H [hex] CAMopen_Error_Reg_0x20 [l = H [hex] CAMNopenState_[x23 |] || [hex]
g | SAnepenSiate 0x02 | “Jihexd | CANopenState_0x20 [ Jihex) | ECM Ausiliary_0x23 [ | thex
7 | ECM_Awidliary_0x02 | Jiheq | ECM Ausiliary_0x20 [ ~|lhex) | ECM Error_Code 0x23 [ | ihe
ECM_Error_Code_0x12 [ -|ihexg | ECM_Errer_Ceds_0x20 [ e | FAR_0x23 [ o
FAR_0x02 I -Io FAR_0x20 I -Io LAM_0x23 I -Io
LAK_ 02 I -1n [N[Car oo I -1n 02_0x23 I BES
= asure do O | Measure dow [6 m|
Q2R_0x03 | - [z] 02_0x21 - [24]

CaMeopen_Error_Cede_0x03 |I - [hex] AFR_Ox21
- | [hex] CAMopen_Error_Code_0x21
- | [hex] CAMopen_Error_Reg_0x21

[ l [
[ l [
[ l [
[ I [
= H [hex] CAMNopenState_0x21 || —H [hex]
[ l [
[ l [
[ | [
[ | [

CAMNopen_Error_Reg_0x03 ||
CANopenState_0=03
ECKM_Avxlians_0x03

l

I
ECM_Error_Gode_0x03 II - | [hex] ECM_Auxiliary_0x21 - | [hex]
1P1_0x03 || - [ ECM Error_Code_0x21 - [hex]
1P2_0x03 ] - uA) FAR_ =21 -n
N 0x03 I - [pprr] [[LAM 0x21 -n

) |Measurement stopped Maz. buffer level: 0%

13. Start CAN monitoring. Right now there is no data displayed. That is because the
CAN monitoring is stopped. To begin CAN monitoring, click on the Start
Visualization icon (blue triangle) on the left hand tool bar. To stop CAN monitoring,
click the Stop Measuring icon (black square) on the left hand tool bar. To begin
recording the data, click on the Start Recording icon (red circle) on the left hand tool
bar.

e | 02 Ox02

I | AFR_0x0Z
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Appendix E: Setting Up ATI Vision for ECM Modules

NOTE: While shown here for a single LambdaCAN module, the same procedure applies for any of
ECM’s CAN-based devices (ex. NOXCAN) as well as for multiple modules simultaneously connected
on the same bus.

Introduction

Connecting ECM LambdaCAN hardware to ATI VISION software is simple and does not require any
third-party software interface. Using the ECM Configuration Tool software to produce a .dbc database
file, and the ATI VISION CANMonitor interface, any available hardware CAN interface can be used to
read LambdaCAN data.

Hardware Setup

A typical hardware configuration is shown in Figure 1. In this example, a Kvaser Leaf Light CAN-USB
adapter is used. Other supported adapters have a similar procedure. Connect the DB9 CAN connector
of the LambdaCAN to the PC to CAN adapter. Supply 11-28V DC (5A min. supply) to the
LambdaCAN.

PC with PCto CAN DB9 Connector
ATI VISION Adapter

and ECM UsB ( .
Configuration L Kvaser Leaf Light

Tool L
Termination
/ Resistor
—1
DC Power Supply
11-28V
|
[ ]
Software

e ATIVISION 3.6.2
e ECM Configuration Tool v4.13

Figure 1: Equipment Schematic Layout
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Creating a .dbc File

The ECM Configuration Tool is used to create a .dbc database file for describing the CAN
messages broadcast from the LambdaCAN. All ECM products with a CAN interface use the

CANopen protocol at 500kHz by default. To generate a .dbc file using ECM Configuration
Tool:

1. Connect hardware as shown in Figure 1. Ensure LambdaCAN bi-color LED indicator
near sensor connector is visible (green during normal operation, flashing red without
sensor attached).

2. Run ECM Configuration Tool software, and select the Modules tab (or the Analyzers

tab if connecting to 5200 series analyzers).

Select CAN adapter from drop down menus as shown in Figure 2, and click START.

4. After LambdaCAN module(s) have initialized, select desired parameters to transmit
from the TPDO drop down menus for each module.

5. Click Generate .dbc, and save this file in a location such as the VISION Projects
folder.

6. Click STOP to end CAN connection.

.

NOTE: Whenever TPDO’s are modified, a new .dbc file must be created.

ECM Configuration Tool || ECM Configuration Tool

Modules ] Analyzers] Firmweare Upgrade] Toggle YW arings [Mow: OFf] Modules ]Analyzels] Firmware Upgrade ] Toggle ‘Wamings [Mow: OFf]

CAN Adapter: [Kvaser ~|[CealLight H3 0[ChD) -] [600Kbpsfoidl_— | [STARTS] Status [l CAM Adapter. [Kaser |[Ceaf light M5 0ichn) < |[500<bpsistd =] STOP | Status: [l

Configuration Toals Configuration Toals
NI Prod ) Rev.#  Senal# ECM Bus Load Log Qfata [0 | NI Prod# FRev#  Serial# ECM = ‘

Log D ata [OFf]
Module: | | | 0% ofps YT | [ Module: [0410 0x02  O40E  0:034D v| | [18% 606 fps AT Do i

Task: | / =) TotolBus Load ManuaIComr’ Set CAN Baud Task | Change Node ID 21| rota Bus Load Manual Comm. | Set CAN Baud

[0%2. 0 ps Colo, %02 inp, w [19%. 824 fps Calo. %02 n Ai

Set

Set Module Mode Flange: 001 - Os7F Set Module Mods

EIB | Stand-tlone ‘ ECM recommends labeling the madule with the new MID. EIB | Stand-dlone

Mate: This function can only be The following CAN 1D are used for each module: Nate: This function can only be
uged with one module on the bus used with one rmodule o the bus

Drata for Nade [D: MAA Data for Nade |D: 010 TPDO: Data transmitted by module

Sensor 5/N TFDOT TPDOZ [~ TPDO3 [~ TPDO4 [~ Sensor S/ TPDOT @ TPDO2 ¥ TPDO3 ¥ TPDO4 ¥
= [ J [ = [ Dracss7) [Law o] [wn o] [ o] [oes o

o [0 [0 [0 Eio [ [325409 (01347 kPa  [c85 ohrns

0x00  |0x00
Eror P CO State | j | j | j | j CO State |02 j |FAH j |”:"I>< j |VHCM j

[o [o [o [o na 0«05 [20954 % |0.307305 [e.om1s  mA 8 Y

www.ecm-co.com * 408-734-3433 « Los Altos, CA, USA = {c¢) 2011 wWWww.ecm-co.com « 408-734-3433 « Los Altos, CA, USA = (¢} 2011

Figure 2: ECM Configuration Tool
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Setup CANMonitor using ATI VISION

ATI VISION CANMonitor provides a method of reading general purpose information from any
available CAN channel. The .dbc file generated by the ECM Configuration Tool is used to describe the
format of the information available to VVISION. To setup a CANMonitor in ATI VISION:

1. Run ATI VISION and open an existing Project File or create a new one by clicking File >
New > Project File. In this example the Project has been named CANMonitorProject.

New... Ctrl+MN

Open... Ctrl+ O

54 Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

[ project File
®HEstrategy File

.EEMX configuration File
ﬁ Calibration File

[ kaM Data File
[Elscreen File

£ ASCIT Text File
@RTF Document File

Description
IVV'ISION project settings and device configuration

2. Add a Device by clicking Device - Add Device, select PC Based CAN Channels from the

list.

HIEI File Edit View Project

Device Tools Window Help

E e SR )

IR

F=| Add Device... F5

=] Remove

=3 Properties Fo

Context Menu

FR5-232 Serial Part

& UsB Port

B8 TCR/IP Port

7 PCMCIA Port

BB Pl Port

SPvirtual CAN Channels
S2PC Based CAN Channels
QSpeciﬁmﬁnns
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Description
IVPC Based CAN Channels on this computer.




3. Add a physical hardware device by clicking Device = Add Device, and select Kvaser CAN
Channel.

i H D
Select Device Type -

H@ File Edit View Project |Device Tools Window Help = omrr—)

« = S
JJ DEegd o o =) 2dd Device... F5 o

=4 Remove Device

Device
Computer &5 Properties F&

N I=] PC Based CAN

Context Menu

Description
(K\taser CAN Channel on this computer

4. Select a CANMonitor device by again clicking Device - Add Device, and select
CANMonitor.

“@l File Edit View Project | Device Tools Window Help SPCAN Monifor
— %CCP Controller Device

JJ D Dq. -'\ E ﬁ @ %%L % %XCPController Device

: B kwP2000 CAN Device (Flash Only)
= Remove Device

T
eTWor
Computer =S| Properties F&

; % IPETRONIK DAQ Metwork
=~ E PC Based CAM

=] Context Menu

Description
IVCAN bus message monitor virtual device
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5. Add the .dbc file generated from the ECM Configuration Tool to CANMonitor by clicking
Device - Add CAN Database and browsing to the previously created .dbc file.

Lookin: | | VISION Project ~| « & et E
Hlﬁl File Edit View Project | Device Tools Window Help ! — |

— FE] dd CAN Database... = eme Defe modifie? | Tvee
O e JdEl s =2 ‘ | Samples 9/29/2011 3:18 PM  File folder

={ Remove Device - || LambdaCANTest.dbc 9/30/2011 5:27PM  DBCFile

Computer & Properties F&
= WIS2 PC Based CAN
= W52 KvaserChannel CANMenitor 3

T Citivorecr ore

1

File name: ILambdaCJ\NTest.dbc

Files of type: |CAN Database Files (*.dbe:"uef)

6. Enable the hardware by clicking Project = Online. The status of all of the devices should

now show a Status of Online, and a value should appear in the Data Rate column of the
Project window.

JIEI File Edit View | Project Device Tools Window Help

|D % oo ! CENEEEECE - |

2 \ehicle Manager...
Device fus

’ Computer Proposed Values » line
= w52 PC Based C/ ne
= W52 KvaserT| M Panic Apply Base F12 ne
= WIS2 CANMGHTET THtline

e e hcte
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7. To view data, create a new Screen File and add a Control. Click File > New - Screen File

inle View Tools Window Help

O ([ & e 6 6 o |
Open... Ctrl+0

=
& Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

8. Select Object > Add Control - Gauge

ile Edit View Project | Object Dataltern Tools Window

@ Delete Ctrl+Delete

Tile controls

m Cut
Copy
Paste

B Properties F&

|

DEeR@ =

Ctrl+F10

Context Menu
Track Residency
5] Clear Residency

(5] Project File
®Estrateqy File

®EEMY configuration File
ﬁ Calibration File

[ kaMm Data File
Screen File

L) ASCIT Text File
gRTF Document File

Description
VISION real-time document used for interacting with data

EData List

BB stripchart Recorder

E=12D Table Grid
[E 30 Table Grid
E5tate Array
(% Gauge

1 Bar Graph

:i, Thermometer
@ LD

aLED Array
5 Seroll Bar
Oypial

i Switch

% Dashboard
CAN Trace

"Descripﬁon

Gauge
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9. Inthe Select Data Items window open the CANMonitor file tree to view all of the available
signals. Here the O2% from Node 0x10 has been selected. Click OK to add the Data Item to
the Control.

' Select " Find

I Advanced. .. | OF I

[C1 DatakemGroups Data Item £ I Type | Canicel |
=[] CANMonitor

© E-E0 Node_x10
[ Emergency_x10

(=] Heartbeat_ (<10 Next |
g TPDO1_(e10 —

“er LAM 010 CAN Signal
CAN Signal Help

&4 TPDO2_0«10 :
g TPDO3_(10 Previous |
54 TPDO4_(k10

‘(0] VinualDatattems P —T—

Selected Data ltems I Comments

Add |
Remove |

10. Data should be visible on the gauge.

lam@aa Lty aRE W J

02_0x10 (%)

%  CANMonitorProject

“IDefaultVehicle Zlft @B m|B] =l “‘/ % | B[ o ol ik |+ -

For Help, press F1 |— Default User |Online NUM 10/3/2011 11:46:18 AM_~
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Appendix F: LOCKing and unLOCKing dashCAN*

When dashCAN* is locked, its setup cannot be modified.
¢ To LOCK dashCAN*

Press SYS until “MOd” is displayed.
Press ¥ until “CONE” is displayed. Then press ENT.
Press ¥ until “LOCK” is displayed. Then press ENT.

“50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN is now LOCKed.

Ll A

& TounLOCK dashCAN*

1. Press SYS until “LOCK” is displayed. Then press ENT.

2. “50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN is now unLOCKed.

If an unauthorized person learns that 60 is the key number, contact ECM.
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Appendix G: The NOx Type F Sensor

The NOx Type F sensor (P/N 06-09) is a modified NOx Type T sensor where the exhaust
gases have to pass through an NH3-adsorbing filter before reaching the sense elements inside
the sensor. Therefore, instead of measuring NOx + NH3 (as any NOx sensor does), the NOx
Type F sensor measures NOx only. The NOx Type T sensor is to be used with the
NOxCANt module.

The NOx Type F sensor was designed to measure tailpipe-out NOx. Three-way catalysts on
spark ignition engines produce NH3 when running stoichiometric and rich and diesels with
uera injection will sometimes have NH3 at the tailpipe. Therefore, unless the NH3 is
removed, a NOx sensor at the tailpipe will measure NOx + NH3.

Typically, the filter will adsorb NH3 for 30 minutes to 1 hour. Fortunately, the filter is easy
to replace. The maximum recommended temperature at the filter is 225 °C.

P/N: 06-09A

P/N: 06-09B10 (one shown)

\ P/N: 06-09C

% NPT Thread
Use P/N 12-56 Mounting Boss

Figure G1: P/N: 06-09 is an assembly consisting of:
P/N: 06-09A Sensor Element
P/N: 06-09B10 Sensor Filter (package of 10)
P/N: 06-09C Cap
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& How to use the NOx Type F sensor

1. Put antiseize on sensor thread

2. Put filter on sensor. Filter contains acid so use gloves.
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3. Screw cap over sensor

4. Put antiseize on cap threads




5. Use P/N: 12-56 Mounting Boss (3/4” NPT)

6. Lightly tighten using hex on sensor
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7. During removal, sometimes cap will remain in boss. Use flats to remove.



E C ENGINE CONTROL 586 Weddell Drive, Suite 2

AND MONITORING Stérxwvale, CA 94089-2134

Phone: (408) 734-3433
FAX: (408) 734-3432
Email: sales@ecm-co.com
Web: www.ecm-co.com

EC DECLARATION OF CONFORMITY

We declare under our sole responsibility that the products:

AFM1540 Lambda Module

AFM1600 Lambda and O, Analyzer

DI1S1000 Display head

EGR 4830 Analyzer

NOx 5210 NOx Analyzer

Lambda 5220 Lambda Analyzer

EGR 5230 EGR Analyzer

LambdaCAN, LambdaCANc, LambdaCANd, LambdaCANp Lambda Modules
NOXCAN, NOXCANg, NOXCANt NOx Modules
NOx1000 NOx Module

baroCAN Module

dashCAN, dashCANc, dashCAN+

appsCAN

SIM300, SIM400, SIM500, SIM600, SIM700, SIM800
BTU200

To which this declaration relates are in conformity with the essential requirements of the following standards:
EN61326: 1997/A2: 2001 (Class A & Annex A)
EN61010-1: 2001 (Electrical Safety)

And therefore conform to the requirements of the following directives:

89/336/EEC Electromagnetic Compatibility (EMC)
72/23/EEC Low Voltage Directive (LVD)

Ronald S. Patrick

Vice President Sales
July 26, 2012
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